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LEGAL DISCLAIMER

THE INFORMATION GIVEN IN THIS APPLICATION NOTE IS GIVEN AS A HINT FOR THE
IMPLEMENTATION OF THE INFINEON TECHNOLOGIES COMPONENT ONLY AND SHALL NOT BE
REGARDED AS ANY DESCRIPTION OR WARRANTY OF A CERTAIN FUNCTIONALITY, CONDITION OR
QUALITY OF THE INFINEON TECHNOLOGIES COMPONENT. THE RECIPIENT OF THIS APPLICATION
NOTE MUST VERIFY ANY FUNCTION DESCRIBED HEREIN IN THE REAL APPLICATION. INFINEON
TECHNOLOGIES HEREBY DISCLAIMS ANY AND ALL WARRANTIES AND LIABILITIES OF ANY KIND
(INCLUDING WITHOUT LIMITATION WARRANTIES OF NON-INFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS OF ANY THIRD PARTY) WITH RESPECT TO ANY AND ALL INFORMATION GIVEN
IN THIS APPLICATION NOTE.

Information

For further information on technology, delivery terms and conditions and prices please contact your nearest
Infineon Technologies Office (www.infineon.com).

Warnings

Due to technical requirements components may contain dangerous substances. For information on the types
in question please contact your nearest Infineon Technologies Office.

Infineon Technologies Components may only be used in life-support devices or systems with the express
written approval of Infineon Technologies, if a failure of such components can reasonably be expected to
cause the failure of that life-support device or system, or to affect the safety or effectiveness of that device or
system. Life support devices or systems are intended to be implanted in the human body, or to support
and/or maintain and sustain and/or protect human life. If they fail, it is reasonable to assume that the health
of the user or other persons may be endangered.
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Introduction

1 Introduction

Dear user,

This document will help you to install and configure the Software and Hardware tools
necessary to operate the TC1796. At the end of the instructions described in this Quick
Start, you will have a running environment that could be used as a starting point for
further development or evaluation work.

This Quick Start goes step-by-step through the necessary procedures in order to:

- Install the demo version of Altium’s Tasking tool chain v2.2.r1 (compiler, assembler,
linker, locator, and debugger).

- Install DAVE, Infineon’s Digital Application Virtual Engineer and the plug-in specific
to TC1796.

- Install MemTool v3.4.0 and MTTY.

- Configure the TriBoard and connect it to the PC.

- Generate automatic code with DAVE.

- Create a simple program and compile it.

- Download this program to the TC1796 external RAM and run it.

This simple program consists in having an LED on the TriBoard driven directly by the
TC1796. When running the program, one can see the LED blink.

Further examples, that demonstrate more in details the functionalities of the TC1796
Core and Peripherals, can be found in the Hands-On-Training included in the Starter
Kit CD.

Please note that all the code examples given in the rest of this application note are
aimed at demonstration purpose only. Code is neither optimized nor is its reliability
guaranteed.

If you need more information, please contact your nearest Infineon sale’s office.
Contact information is available on Infineon web site: www.infineon.com.

We wish you a lot of success with the TC1796!

Application Note 4 V 2.0, 2005-06
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Needed Material

2 Needed Material

To execute this Quick Start, it is necessary to have A PC equipped with a parallel port
and one of the following operating system: Windows NT, Windows XP, Windows
2000, Windows 98. Power user’s rights (or administrator rights) are mandatory to
install the programs.

In addition, an AC/DC converter (5.5V -60V) is needed (to supply the TriBoard).
In addition, the following hardware and software tools are required:

Note: All the items below are included in the TC1796 Starter Kit.

- One TriBoard evaluation board for TC1796 BC step.

- A CD-ROM containing the demo version of Tasking Tool Chain v2.2r1.
- A parallel cable.

- DAVE v2.1. and the plug-in .DIP file for TC1796 v2.3.

Application Note 5 V 2.0, 2005-06
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3 Installing Tools.

1. On your hard drive, create the following directories:

- “CA\TC1796_SKV

- “C:A\TC1796_ SK\QuickStart\”

- “C:\TC1796_ SK\Tools\

- “C:\TC1796_ SK\Tools\ MTTY\"

3.1 Installing the Tasking Tool Chain v2.2r1 demo.

2. Insert the Tasking Demo CD-ROM from ALTIUM in your CD-ROM driver. Run
the “setup.exe” file.

3. Select “Tasking Trial Version for TriCore VX-toolset v2.2r1” and press
“Install”. Follow the installation instructions.

| TASKING Showroom x|

ASKIMG Trial Yersion for TriCore Wi-toolset +2
 TASKIME emn o ion o e TWwEh

D ocumentation: j] TASKING
[Releass notes vz. 211 =l
WView |
Embe%ded
oo il bl et you il nod th e de vgjfgﬁé”ﬁ-m

Note: By default, the tool chain is installed in :“C:\Program Files\Tasking\dctc v2.2".

Note: The DAS servers are automatically installed in:
“C:\Program Files\DAS\DAS_v3.1_Edition_1.4v2.2".

Note: At the end of the installation procedure, reboot your computer and proceed with
the next step.

Application Note 6 V 2.0, 2005-06
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3.2 Installing DAVE v2.1.

4. If you are using the Starter Kit, insert the Starter Kit CD in your CD-ROM
driver and run the file “D:\Tools\DAvE\setup.exe”

Otherwise, insert a CD-ROM containing DAVE and run setup.exe.

Follow the installation instructions in order to install DAVE.

Note: By default, DAVE is installed in :“C:\Program Files\DAVE\”

3.3 Installing the TC1796 plug-in for DAVE.

Ed
5. Double-click on the DAVE icon on your desktop:

6. Inthe menu bar, select: View = Setup Wizard.

7. Inthe pop-up window:
- Select “installation”.
- Press “Forward”.

1 DAE Setup Wizard : x|

‘Wwelcome to the DAVE Setup Wizard. The DAYE Setup ‘Wizard
guides pou through the installation or uninstallation procedure of
products for DévE. Products for DAYE can be Addln's, support for
micracantrollers ar suppart far other Infineon products.

The DAYE S etup "Wizard will give you important hints if you want
ta install products from the DAYE CD-ROM ar from the DAYE's
web site

L | First you have to selzct if o want the DAVE Setup wizard to
guide you through the installation of the uninstallation procedure.

LCancel

Application Note 7 V 2.0, 2005-06
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8. In the next pop-up window:

- Select “l want to install products from the DAVE’s web site”.
- Press “Forward”.

F DAYE Setup Wizard x|

Please select if you want to install products from the DavE
CD-ROM or if you want to install praducts from the DAVE's
wieh site

| | want to install products from the DAYE CD-ROM

7+ | Bvant to install products from the DAVE s web site:

_ae—

<Bao Cancel

9. In the next pop-up window, :

If you are using the Starter Kit CD, browse for “D:\Tools\DAVE\” and click
“Forward”.

Otherwise, browse for the location containing the DIP file for TC1796 and
click “Forward”.

Application Note 8 V 2.0, 2005-06
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10. In the next pop-up window :
- Select “TC1796".
- Press “Forward”.

,): DAvE Setup Wizard

See the details for a product by clicking on it in the list. Select the products which have to be
installed by checking the box on the left of each product.

[ghyailable Product

[~ Product Detail

Projsct Support

Wersion:

Requires DAYE 21
[or higher]

Size: 4012 KB

Free disk space 14137.08 MB
Required disk space: 3,92 MB

< Back ‘ Eorward > ! ’ LCancel

In the next pop-up window: Press “Install”.

11.

BT

To install the products in the list press the install button, To modify
the list press the back buttan.

TC1796

< Back T Tnstall ' Cancel

The installation of DAVE is now finished. DAVE is now ready to work with the TC1796!

Application Note V 2.0, 2005-06
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34 Installing MemTool v3.4.0.

12. If you are using the Starter Kit CD, run the following executable
“D:\Tools\MemTool\ap1606034_MemTool_V3.exe”.

Otherwise, browse for the location containing this file.
Follow the installation instructions in order to install MemTool.

Note: By default, MemTool is installed in: “C:\Program Files\Memtool\”.

3.5 Installing MTTY.

13. If you are using the Starter Kit CD, you can find MTTY.exe in the following
folder: “D:\Tools\MTTY\".
Copy MTTY .exe to the following directory in your hard drive:
“C:\TC1796_ SK\Tools\ MTTY\".

All the software tools are now installed. From the next section on, we will use them
in order to program the TC1796.

Application Note 10 V 2.0, 2005-06
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4 Configuring the TC1796 with Dave.

In this section, it will be shown how to configure the TC1796 and how to generate
automatically code.

)

14. Double-click on the DAVE icon on your desktop: 8

15. In the start-up dialog, click on: ‘Create a New Project’, or go to: File > New.

& DA¥E - Startup Dialog

’ DAVE Tutorial
l Open an existing project

[ S—

| Create a new project

| Close this dialog
| Close dialog and do not show it again

Application Note 11 V 2.0, 2005-06
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16. In the pop-up window, select TC1796, and click on ‘Create’

Note: You may have more choices, if more plug-ins are already installed.

& DAVE - New Project x|

32-Bit Microcontrollers I

2
T o= 1D

Cancel |
Help |

17. The ‘Project Settings’ window opens automatically.

In ‘General’, select Tasking v2.0.

& Project Settings x|
B
General ISyslem C\uckl Intermapt Sysleml PCP Systeml Pad Driverl Starlup Cunfiguratwunl Nulesl
r— Contraller Type
Type [TC17s =

Max. spstem clock IW 50 MHz

r~ Main S ource Fil tdain Header Fil

File name MaIN.c ’V File name MaIN.h
i~ Compiler 5 etting:

 GHU

" Tasking 1.5

Application Note 12 V 2.0, 2005-06
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18. In ‘System Clock’, select :
- External Clock Frequency: 20MHz.
- Input divider PDIV: fp = fosc /2 = 10,000 MHz.
- Feedback divider (NDIV): fvco = fosc / P *60 = 600,000 MHz.
- Output divider (KDIV): fcpu = fvco / 4 = 150,000 MHz.

& Project Settings x|
” ™| ¢t -| ?
General I Intermupt Sysleml PCP Eysteml Pad Drivarl Startup Ennfiguratinnl Nntesl

i~ External Clock Frequenc:

Erternal clock Freq O PLL Bypass operation [fopu = fosc]
[MHz] [pin BYPASS =1)
Input divider [PCIV] <I ,E = fosc 4 2 = 10,000 MHz - >

i Woltage Contralled O scillatar [VCO)
I™ VCO Bypass mode (VCOBYR)

VCO range [VEOSEL) 500 MHz - 700 MHz 4|

Feedback divider [NDI - S WO output Er—
eedback divider [ fvca = fosc /P60 =600000MHz =) ¢o0 Sobhy ) [EO0.000

r— Output Divider

A —
Dutput civider (KON Qe oo /4~ 150,000 Mz > [Erm]t'mk 160.00000000
% The ratio fepu £ feysis 2 /1 System Clock 75,00000000
[MHz]

" The ratia tepu / fsysis 141 B

19. Clickon: [ and save the file using the following path:
“C:\TC1796_SK\QuickStart\QuickStart_example.dav”

20. Let now DAVE generate code for you, by clicking on: %

Note:  DAVE opens a new window with the Project Documentation file. On the left
hand side a browser window shows the generated files. You can take a look
at the generated code or just find out in which file DAVE put the included
functions. In general: if the included function is a macro it is included in the “.h’
file; if the included function is a function it is included in the ‘.c’ file

Application Note 13 V 2.0, 2005-06
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5 Creating a project with Tasking.

In this section, it will be shown how to create a project with Tasking, to set-up compiler
options and to compile the project in order to generate an .elf file that can be
downloaded into the TC1796.

5.1 Creating a project

21. Open an EDE session by double-clicking on the icon on your desktop:

22. In the menu bar, select : File > New Project Space

23. In the dialog box:
- Browse for: “C:\TC1796_SK\QuickStart\QuickStart_ps.psp”.
- Click 'OK’

Create a New Project Space 1[

Current Directony:
C:\Program Filesh TASKING \dote w2 2Yexamplesiuwiy

Filename:
< |§\ TC1796_SKAQuick StartyQuickStart_ps.psp >

v Look in zame directary for external workspace —‘

“wiorkspace:
Tupe:
= st sphie workspace

74
owe QC0CD coea | i |
4

Application Note 14 V 2.0, 2005-06



{

Infineon

technologies

AP32077
Quick Start

Creating a project with Tasking.

24. In the ‘Project Properties’ window, click on the ‘add new project’ icon.

Project Properties _ x|
Directries | Members | Tooks | Erors | Fikers |
Project Space: 4 TC1796_SKAJuick! ickStart_ps.psp
Projects: x| B
™ Hide projects aleady in project space
r~ Extemnal Workspace:
<hone> B
Concel | Help
A

Note: You can access the ‘Project Properties’ window by selecting in the menu bar:
Project 2 Properties.

25. In the dialog box:
- Browse for: “C:\ TC1796_SK\QuickStart\QuickStart_example.pjt”.
- Click 'OK’

Add New Project to Project Space 5[

Current Directory:
C:A\ TC1796_SKAQuickStart

Filenarme:
< |E:\ TC179E_SKAQuickStath D uickStart_example. pit >

v ook in same directony for external makefile
I akefile:
Type:

I futo sy makefile

2
Cancel | Help |
A

The ‘Project Properties’ window gets updated.

Application Note 15 V 2.0, 2005-06
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26. In the ‘Project Properties’ window, click on the ‘add existing files’ icon.

Project Properties ZI

3 <Default Settings> Directories I tembers I Tools I Enrars I Filters I
QuickStart_ps (1 Projsct] Project: CATC 796 DuickStathuickStart_sxample.pil

el | Files: 3 i1|| ]

I Hide files already in project

i~ Estemnal Makefile:

<nones B
—WCS Project:
<nones Bl
™ addproject files to WS Project
e | Bl
Cancel Help

27. In the dialog box, select:
- "C:\TC1796_SK\QuickStart\main.h”.
- "C:\TC1796_SK\QuickStart\imain.c”.
- Click 'Open’

The ‘Project Properties’ window gets updated.

Application Note 16 V 2.0, 2005-06
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28. In ‘Project Properties’ window, click ‘OK’.

Project Properties. E x|
3 <Default Settings> Directories l Members l Taok I Enars I Filters I
(&) QuickStar_ps (1 Project Project £:4 MuickStatQuickStart_ssample pit
B 0 example 2 File

[ Fies RS

CATC1736_SKNQuickStarttMAIN. h
CATC1736_SKNQuickStarttMAIN. o

™ Hide files already in project 0of 2 selected
~ External Makefile:
<none> EI!I
~WCS Project:
<nones BT
= Add project files to#/ES Froject

KT i

oK Cancel Help
Lo |) =N

—~— £

The project is now created. It and its assigned files appear in the browser
window on the left of the main Tasking window.

Application Note 17 V 2.0, 2005-06
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5.2 Setting the project options.

29. In the menu bar, select: Project > Project Options.
30. Processor > Processor definition : select TC1796B

TriCore ¥X-toolset Project Options [QUICKSTART_EXAMPLE.PIT] 5'

[~ Processor Definition

Target processor. @ | TC17968 >

::Ttéznh uration The FPU and MMU options are anly relewant for user defined processors.
C Corpiler a A possible FPU /ML in the selected CPU will be supported regardless
the state of the grayed checkbox,

- Assembler
PLCP Assembler I FFU present

+)- Linker I~ ML present
Crossiew Pro

= Processor

Ok I Cancel Default... Help

Application Note 18 V 2.0, 2005-06
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31. Processor > Bypasses: tick ’All Bypasses’.

TriCore ¥X-toolset Project Options [QUICKSTART _EXAMPLE.PIT] ﬂ
O Processar Functional Problem Bypasses TC1796
Processar Definition < v Al @passes TC1796
_—> Bypasses
Er [T CPU_TC.073 (s== rote] -
o us.l anfiguration ] CPU_TC 048
. UF”E: = 01 CPU_TC.060
'PESF?E er . ] CPU_TC.06S
e Ssembler [ CPU_TC.088
O] crU_TC. 053
- CrossView Pro O cru_TC.070
] cru_TC.0A
O crU_TC.072 =l

Mate: The spstem startup code (ibherchestart asm] must have been
added to vour project.

ok I Cancel | Defaul... | Help I

32. C Compiler - Preprocessing: disable ’automatic inclusion of .sfr files’.

TriCore ¥X-toolset Project D ns [QUICKSTART_EXAMPLE.PIT] 5[

=- Processar Preprocessing
- Processor Definition Store the C compiler preprocess output [<file>.pre)
- Bupasses utomatic inclusion of *si' file [2.g. disable for DAVE prajects]
[#- Startup
- Bus Corfiguration Define user macros, e.g.: VALUE=100,SERIAL
=) C Compiler
- Preprocessing I
- Language

- Debug |nfarmation
- Code Generation
- Optimization

- Allocation

- W amnings

- MISRA-C

- Miscellaneous

- Azsembler

- PCP Assembler

- Linker

- Crossiew Pro Options string:

Awie-noctasking sfi -Ctel 796D Wie-c93 Wo-ds We-g —switch=auto =
“we-align=1 -Wc-02 w2 -inline-mar-incr=35 -inline-max-size=10

Swic-MB -"$PRODDIRMinclude” --siicon-bug=all-tc1796

QK I Cancel Default. Help I

Include this file before sounce:

| Browse... I

[3]- [ [

Application Note 19 V 2.0, 2005-06
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33. C Compiler - Optimization: select ‘No optimization’.

TriCore ¥X-toolset Project Options [QUICKSTART_EXAMPLE.PIT]

- Processor
[=1- C Compiler
- Prepracessing
Language
Debug Information
Code Generation

_-} Dptimization

34. C Compiler - Allocation

Allocation
‘Wamings
HISRA-C
Miscellaneous

CrossView Pro

TriCore ¥X-toolset Project D)

with Tasking.

i~ Optimization

—
Optimization le: Ma optimization
Size/speedifrade-off. [Level

Custom optimization;

Coalescer; remove unnecessary moves

Common subexpression elimination [CSE]
Expression simplification
Control flow optimization and code reordering

Generic assembly optimizations
1 Function infining
Instruction scheduler

[~ 2ll addresses avallable for CSE evaluation

Mawimum size increment inlining: |35
Mawimunn size for functions to always inline: IW 1}

Options sting

wc-no-tasking-sh -Chel796b Wie-c99 We-bi Mo -switch=auto
“w'c--align=1 “wi-00 -inline-max-incr=35 ~inline-max-size=10 “wi-NB
H"$(PRODDIRJsnclude" ~silicon-bug=alktc1796

.

Cancel

Defaul... Help |

: remove ‘Default __near allocation’.

ns [QUICKSTART_EXAMPLE.PIT]

Processor
[=- C Compiler

i Preprocessing
Language
Debug Information
Code Generation
COiptimization

Application Note

Allocation

- Wamings

- MISRAC

- Miscellaneous
- Assembler

- PCP Assembler

- Linker

- CrossView Pro

[ [

[ atio

[~ DRfault __near allocation for objects below threshold |2
efault a0 allocation for objects below threshold |0
[~ Default __al allocation for objects below threshald |0

Options string:

AWe-notasking-sfr -Cte1796b We-c39 Wo-Ar We-g -switch=auto
wic-align=1 w00 ~inline-mas-incr=35 --inline-max-size=10 “w'c-N0
1"$[PRODDIRMincIude" —silicor-bug=al-te1 796

aK I Cancel Default... Help

20
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35. Linker - Script file > Internal Memory: CSRAM:
- Alloc: select ON.
- Type: select ROM

TriCore ¥X-toolset Project O| ns [QUICKSTART_EXAMPLE.PIT] ll
- Processor ~ Intemal Mermor
t C Compiler Name I Alloc | Type | Size I Addiess I
-Assembler brom OFF  ROM S
- PCP Assembler Imbram OFF R Gk 0xC0000000
=1+ Linker dsram OM RAM SEk. 000000000
i Output Format dpram Bk 0<D000EO0D
[=I- Script File csram 48k 0D 4000000
L. Special Aveas pram " 16k OxFO0S0000
Defines/Stack Heap poode OM PCPCODE 32k OxFO0E0000
; Internal bMemory
Esternal Memory
Sections
Output Sections:
Reserved
-~ Map File
- Libraries
Optimization
- Warmings
- Mizcellaneous Options string:
b1 Crosstiew Pra -format=elf -o"'quickstart_example.elf"' -d"_quickstart_sxample.lsl" ;I
-Cte179Eb --silicon-bug=all-te1796 “wl-h wl-metkiMaliSU
L"$PRODDIRMBASPROTECTED] *wA-OCLTXY J
ak. I Cancel Default... Help |
7]
36. CrossView Pro - Execution Environment :
- Select: ‘TriBoard (TC1796B) via DAS’.
- Click ‘OK’
TriCore ¥X-toolset Project Dptions [QUICKSTART _EXAMPLE.PIT] 1'
Processar i~ Execution Environment
E‘ EUWE:H Execution enwiranment GiliB oard [TC179EB] via DAS =2
ssembler
FCP Assambler DAS TCPAP Settings (host part] Ilnca\hnst,ZJ
Linker
- CrossView Pro Tiarget configuration file [%.cfg):
el - Ecution Enironment Browse. I

imulator
Loaging
RADKM
iscellaneous

Options string:

-tefg infineon_triboard_te1736b_das.cfg - tepiplocahost.23 -C to1 7960 —i;l
-load_application_goto_main=true --sync_on_halt=on -2 100 -b 500 - 26

|
‘ oK I ’ Cancel Default. | Help /lA

Application Note 21 V 2.0, 2005-06
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37. In the main menu, go to Project > Save Options, and save the options at

the following location: “C:\TC1796_SK\QuickStart\QuickStart_opt.opt”.

Writing code

x|
C:ATC1 7964 D uick StartQuick Start_ps.psp
QuickStart_ps [1 Project]
EI% QuickStart_example (3 Files]
Ela Source Files
art 2 CATCT 796
{ CATCI796
1459 Header Fles
[ MAIN.h CATC1736
(L] Project Files
++[7] Resource

38. In Tasking main window, in the browser on the left, open the file ‘Main.c’.

Application Note

39. In ‘Main.c’, almost at the end of the file, the code below has to be inserted
between the two comments:
// USER CODE BEGIN (Main,9),and // USER CODE END.
ive i, i
// Define Port 1/Pinl5 as general 10
2l I0CE12 = gxs0000000;
// endless loop
while (1)
// set led off
P1 OUT = 0x00008000;
// dummy operation
for (1=0;1<1000000;1++)
j=i;
// set led on
P1 OUT = 0x00000000;
// dummy operation
Eor (i-0;1- 1000000 01F)
j=1;
!
22 V 2.0, 2005-06
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Note: DAVE doesn’t change code that is inserted in the ‘USER CODE’ sections if you
let DAVE regenerate code. Therefore, whenever adding code to the generated
code, write it into a USER CODE’ section. If you want to change DAVE
generated code or add code outside these ‘USER CODE’ sections you have to
modify your changes after each time you let DAVE regenerate code.

5.4 Compiling and Building the project

40. In the menu bar, select: Build = Build, or click the icon.
The program should be compiling with no error message. At the end of the
building process, the file “quickstart_example.elf” is created.

Note: There may be some warning after the compilation. Just ignore them.
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6 Connecting the TriBoard.
41. Connect the TriBoard to the PC via a parallel cable (a cable is supplied with
the Starter Kit).

42. Connect a DC power supply (5.5V — 60V) to the TriBoard. Three LEDs
should be on.

PC < [

DC PSU
5.5V- 60V

Figure 1 Connecting the TriBoard to a PC and a power supply.

43. Verify that the jumper J501is connected to position 1-2 (see picture below).

44. Configure the DIP switches so that: 1, 2, 4, 5, 6 are ON, the rest are OFF
(see picture below).

45. Press the blue reset button (see picture below).
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b PSU (TN
5.5V- 60V T

Figure 2 Hardware settings of the TriBoard.

Note: For more information on the TriBoard, please refer to the TriBoard Hardware
Manual (contained in the Starter Kit CD).
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7 Starting a DAS session.

46. Open file das_gui_device_scanner.exe. This file is located by default in :
“C:\Program Files\DAS\DAS_v3.1_Edition_1.4\clients”.

The “DAS Device Scanner” window pops up.

47. Click on “Start DAS Server”.

Il DAS Device Scanner o ] o9

Host Computer: |([ab=]lglkg ] Change
Start DAS Server

Info | Start Client ]

Start Client |

Info
Info | Start Client ]

Info | Start Client |

J
J
J
J
}[W Start Client |
J
J

Info | Start Client |
Info | Start Client]

Info | Start Client |

A new window “DAS Server Control panel” pops up.

——— s — —— — ——
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48. In this new window, click on “Installed Servers”.

iIH DAS Server Control Panel g s 3 |

Host Computer: [ais=[lglat J Change
& Installed Servers

Running DAS Servers

Info | Terminate |

J
J
] Info | Terminate |
J

)
[ )
[ )
[ )

Info | Terminate |

A new window “Installed DAS servers” pops up.

49. In this new window, click on “Start” in order to start the JTAG via LPT server.

=loix|
Hast Computer: [lacalhost ]
Installed DAS Servers

UTAG JORYLPT || e st
( || infa | Start
| |[{infa. | start |
( || infa | Start
| || info | Start |
| || infa | Start |
| || info | Start |
| || infa | start
| |/ 'info | Start |
| || infa | start
( || infa | Start |
| || infa | start
( || infa | Start |
| || “infa | start |
( |[infa | Start
| || Tinfa | start

Now, if you look back at the “DAS Device Scanner” window, you can notice
that TC1796B has been detected.
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8

Debugging an application with CrossView.

Debugging an application with CrossView.

50. In Tasking, start the CrossView debugger by clicking on the icon: @I

51.

CrossView opens automatically and download the application
quickstart_example.elf.

In CrossView, click on the icon: > . in order to run the application

The LED on Board is now blinking. The TC1796 executes the program
successfully!!
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Conclusion

9 Conclusion

In this document, the different steps to save a simple program in the on-board external
RAM of the TC1796 have been described

For more application hints on how to save code in other locations (internal Flash,
internal SRAM) and how to operate the Core and peripherals of the TC1796, please
refer to the Hands-On-Training included in the Starter Kit CD-ROM.
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